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The LIOBOX² is a MIDI controller that lets you control your Ableton, Bitwig, Reaper, Pro Tools, 

Logic Pro, QLab and other MIDI-compatible Digital Audio Workstations (DAW). 

It integrates the software's transport functions, as well as session song display. 

 

The LIOBOX² also lets you create and save setlists within the device, so you can rearrange the 

sequence of songs without having to modify your projects. 
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REVISIONS 

 
Revision Date Modifications 

v11 May 2026 Adding Bitwig support 

v10 March 2026 Adding Loop capabilities 
Update script naming convention 
Updating Pro Tools, Logic Pro and QLab 
procedures 
Adding Covered Versions section 

v9 Nov 2025 [ALPHA] Adding Native support for Pro Tools, 
Logic Pro and QLab 
Naming convention updated 

v8 June 2025 Adding Liobox track name compatible 
characters 

v7 March 2025 Ableton script path for WIndows updated 
Script version set to currently available 

V6 January 2025 New version 

 

COVERED VERSIONS 
This User Manual was written with the features of the following firmware, software and script 
versions. 

Ensure your Liobox, Script and GoorooLink versions are up to date to benefit of the latest features, 
bug fixes and stability improvements 

Element Version 

Liobox² Firmware v6.1.2 and above 

Ableton Script v3.1.7 

Reaper Script v1.1.0 

Bitwig Extension v1.0.0 

GoorooLink Software v1.1.0 and above 
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LIOBOX² DESCRIPTION 

 

 

ABCD  PAD A B C D - Pads assignable to various software functions or midi information 

E   ​ PAD E - MENU / BACK - Access the menu and return to the main screen 

F   ​ PAD F - BANK CHANGE / BACK - Change PAD bank C D E F and go back in submenus 

G   ​ 3.5-inch color display 

H   ​ Clickable knob - Menu navigation and next/previous song selection/launch 

I    ​ USB A - Connection to the Master computer 

J​ USB B – Connection to the Spare computer 

K​ MIDI Out – 3.5mm jack MIDI Output 

L​ MIDI IN – 3.5mm jack MIDI Input 
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USAGE 
The Liobox² is a MIDI controller that natively integrates with Digital Audio Workstations (DAW). 

 

Native integration 

The Liobox² has been designed to work automatically with Ableton, Bitwig and Reaper without 
additional plug-ins. To benefit from the same features on Pro Tools, Logic Pro and QLab, the use of 
the GoorooLink software is required. 
An example of this seamless integration is that the Liobox² can retrieve song names and information 
from a project without requiring the user to perform any action.  

Moreover, it gives access to extended transport, autostop, loop and autonext functions. 

 

Setlist management 

The Liobox² allows creating and recording multiple setlists in-box, with no need for a computer or 
additional plug-ins. No need to change your DAW project. 

 

Compatibility 

The Liobox² is compatible with all MIDI DAW that can interface MIDI devices. 

Native integration is currently available for Ableton, Bitwig, Reaper, Pro Tools, Logic Pro and QLab. 

 

Refer to this section for details on how to set up the DAW with the Liobox². 

 

The Liobox² fully supports Windows version 10 and 11 as well as MacOS from version Mac OS X. 

PADS (A, B, C, D) 
The LIOBOX² has 6 RGB backlit silicone pads with click buttons. Each pad has a predefined function, 
but can also be modified as explained in section 3. 
 
Predefined functions 
A- PLAY: Launches the next song selected. By default, after launching a song, LIOBOX² automatically 
selects the next song in the list. 
 
B - RWD: Long press launches fast rewind.  
A single press selects the next song without launching it. 
Double-clicking restarts the current song. 
 
C - FWD: Long press launches fast forward.  
A single press selects the next song without starting it. 
 
D - PAUSE: Pauses playback. A second press resumes playback.  
During playback, a quick double press sends a STOP and places you on the first beat (1.1.1). 
 
E - MENU: Enters the LIOBOX² menu to access settings and setlist functions. While in the menus, 
pressing the MENU pad takes back to the home screen. 
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F - BACK/BANK CHANGE: In the MENU screen, return to the previous menu. In the MAIN screen, it 
allows selecting PAD Banks. 

CLICKABLE KNOB (H) 
The clickable knob (or selective notched encoder) is used to move through the MENU options and 
validate selection. 

On the MAIN screen, the encoder is used to select the next song to be played by rotating it. The next 
song is launched by clicking on the encoder. 

USB PORTS (I, J) 
The LIOBOX² has two USB2 MIDI ports, named USB A and USB B (I and J respectively in the above 
drawing): 

●​ USB A is recognized as “Liobox MASTER” 
●​ USB B is recognized as “Liobox SPARE” 

 

The LIOBOX² can also be connected to a single computer via the USB A port (as with the LIOBOX 
version 1). 

Connecting two USBs enables redundancy, further described in this section. 

 

Note: only the USB B port can enable software update with the Gooroo Configurator.  

JACK PORTS (K, L) 
The LIOBOX² has two MIDI 3.5mm jack ports: 

●​ MIDI IN port: controls LIOBOX² internal functions from an external instrument 
●​ MIDI OUT port: controls an external instrument 

 

DISPLAY (G) 
The Liobox² 3.5” screen displays customizable information removing the need to have a direct 
access DAW. 

 

The MAIN screen can display (in ADVANCED MODE): 

8 
 



     ​  
LIOBOX² - USER MANUAL v11 

 

The MAIN screen can display more or less information depending on the selected setting. Refer to 
section Screen Preference to view all available options. 

 

The MENU screens allow a full customization of the Liobox² as well as Setlist creation and navigation. 

SETLISTS 
To access Setlist management, enter MENU→ SETLIST. 

Setlist allows creating customized, quickly accessible lists that can be changed on the fly.  

It removes the need to change the active project.  

 

Note: the Liobox² setlists are based on but never modify the Ableton, Bitwig, Reaper, Pro Tools or Logic 
Pro projects. 

 

Depending on the selected mode, Setlist management behaves differently: 

●​ Ableton, Bitwig, Reaper, Pro Tools, Logic Pro(native modes): songs/markers are gathered 
from the active project and can be added to the Setlist 

●​ Midi: setlist allows creation of internal markers from which individual Midi messages are 
associated allowing direct mapping via DAW settings. 

 

Important: created setlists are only compatible with the mode they are created. For instance, an 
Ableton setlist will only be compatible with Ableton mode. 

Note: up to 9 setlists can be created. 

 

Setlists can be managed directly from the Liobox²: 

●​ Creation 
●​ Modification (song/marker list management, setlist renaming) 
●​ Duplication 
●​ Removal 
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Creation 

In the SETLIST menu, select the last entry + ADD [MODE] SETLIST. 

Make sure to select the proper mode prior to creating the setlist. 

 

This entry will not be available if the maximum number of setlists is reached. 

 

Modification: load setlist 

To have the Setlist active, it is necessary to Load it. 

From the Setlist menu, select Load Setlist 

The name of the loaded setlist is permanently displayed in the bottom right-hand corner of the 
screen. 

The Setlist name can appear red if the Mode is different from the type of Setlist created. 

 

Modification: song/marker list management 

Song loading and management is different depending on DAW used: 

●​ Ableton 
●​ Bitwig 
●​ Reaper 
●​ Pro Tools 
●​ Logic Pro 
●​ Midi 

 

Modification: renaming 

Setlist name can be modified.  

The list of allowed characters is below: 

●​ Letters: A-Z 
●​ Numbers: 0-9 
●​ Parentheses: (  ) 
●​ Square brackets: [  ] 
●​ Special Characters: #, &, +, / 
●​ Space 
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Press the knob to move to the next character and to confirm the newly assigned name. 

 

Duplication 

Enter the Setlist and scroll to DUPLICATE SETLIST entry. Once confirmed, the menu switches back to 
the SETLIST menu where the duplicated setlist appears. 

 

Removal 

Simply enter the Setlist and scroll to DELETE SETLIST entry. Confirm twice and the Setlist will be erased. 

REDUNDANCY 
The LIOBOX2 can be used simultaneously with 2 computers running in sync: one Main and one 
Spare. This allows the Spare computer to take over in case of a Main computer failure therefore not 
disrupting neither the show or its control. 

Note: for audio redundancy, a redundant sound card should also be used. 

 

When the spare script is loaded into the second computer, this identifies the Liobox² as the backup 
computer.  

The Liobox² therefore sends information to the spare unit but does not display feedback from the 
spare computer, to avoid conflicts with the main computer. 

When the spare unit is connected, the Liobox² compares the song lists of the main and spare 
computers to ensure that the sessions are identical.  
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ABLETON 

SETUP  
Before connecting the LIOBOX² to the computer, the script corresponding to the software version 
must first be loaded. The script is a small folder allowing data exchange between Ableton and the 
Liobox². 

 

When using two computers in redundancy, the script with the "spare" extension shall be loaded on 
the second computer. This enables LIOBOX² to differentiate between the two computers. 

 

Add the Ableton script on MacOS 

●​ In the Applications folder, right-click on the Ableton icon and select "show package 
contents". 

●​ Drag the scripts corresponding to the software version into the "MIDI REMOTE SCRIPT" folder. 

 

 

 

Add the Ableton script on Windows 

●​ Copy script folder Liobox2_Master and Liobox2_Spare in the following folder:  

<path_to_Ableton>/Ableton/<version>/Resources/MIDI Remote Scripts 

 

 

Warning: given the change in supported Python version between Ableton 10, Ableton 11, Ableton 12.0 
and Ableton 12.1, load the correct script for your version of Ableton. 

 

Load the script on Ableton 

1.​ Connect the LIOBOX² to the computer and start Ableton. 
2.​ In Options → Settings, select Link, Tempo & Midi 
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3.​ Load the script on the Control Surface dropdown 
4.​ Assign the Liobox Port 1 to both Input and Output 

 

 

 

The script works similarly either in Ableton Session or Arrangement mode. 
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SCRIPT ADVANCED FEATURES 
The Ableton and Bitwig scripts support advanced features allowing to: 

1.​ Autonext: marker launching a “next song” commands request from the Liobox, executed by 
the Liobox 

2.​ Autostop: marker executing a Stop command 
3.​ Loop 

 

Autonext 

It consists of a “Next” request to launch the Liobox next marker (not the session next marker). 

 

To use this feature, add a “(NEXT)” marker in your session. The command will be executed when the 
playhead will pass over it. 

 

 

Autostop 

Similarly, the “Stop” marker triggers a STOP request from Ableton/Bitwig (and not from the Liobox) 

 

To use this feature, simply add a “(STOP)” marker in your session. The command will be executed 
when the playhead will pass over it. 

 

 

Loop 

The script's LOOP marker automates Ableton/Bitwig LOOP section: 

●​ “(LOOP)": creates a 4 beat infinite loop 
●​ “(LOOP X)": creates an infinite  loop of X beats 
●​ “(LOOP X // Y)": creates a loop of X beats that will repeat X times and then deactivate. 
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Loops can also be created on-the-fly with from the Liobox. Refer to section  

 

MIDI OUT - CONNECTION WITH AN EXTERNAL MIDI 
INSTRUMENT 
The LIOBOX² features a second virtual MIDI port through which you can transfer MIDI information 
(Note, Control Change, Program Change) from Ableton to an external instrument. 

●​ Select port 2 on the LIOBOX²  
●​ Assign it to the MIDI song. 

 

 

To connect the external instrument, use a 3.5 mm jack cable or a MIDI DIN to 3.5 mm jack adapter, 
also referred to as a Type A Midi. 
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REAPER 

SETUP 
Note: the following instructions are given for Reaper v7.27. Reaper is frequently updated by its 
developer therefore the instructions might vary slightly from version to version. 

 

Prerequisite: download and install the SWS/S&M extension for REAPER 
(https://www.sws-extension.org/).  

Installation instructions:  

●​ Windows: simply run the installer 
●​ MacOS 

a.​ Download: select “ARM64” if using Mx processors or “X64” if using Intel processors 
b.​ Launch the installer 

 

c.​ Drag and drop the reaper_sws-PROCESSOR.dylib into the /Library/Application 
Support/REAPER/UserPlugins folder. If the folder does not exist, create it manually. 
The other files are not required for the Liobox² to run. 

 

d.​ Launch REAPER 

Note: if a security alert is popping up preventing proper Reaper opening, concerning the just copied 
library, go to the MacOS Settings ⇒ Privacy and security settings.  

Close Reaper, scroll down until reaching the request to authorize anyway. 

When Reaper is launched again, make sure to Open the SWS library. 
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To validate that the SWS/S&M plugin is properly installed, open Reaper > Extensions. SWS/S&M menu 
shall be present: 

 

 

Reaper preferences: 

Go to Options/Preferences. 

MEDIA section: disable “Set media items offline when application is not active” 

 

AUDIO section: disable “Close audio device when stopped and application is inactive” 
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AUDIO/PLAYBACK section: disable “Stop/repeat playback at the end of project” 

 

 

Liobox configuration 

1.​ AUDIO/MIDI INPUTS: enable “All” for the “Liobox ***” device 

 

2.​ AUDIO/MIDI OUTPUTS: enable “Enable” for the “Liobox ***” device 
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3.​ AUDIO/MIDI OUTPUTS: disable “Reset on: Play” 

 

 

IMPORTANT: the script is going to search for the Liobox by checking if a MIDI device starts with 
“LIOBOX”. if your Liobox Alias name is different (often the case on MacOS). It is possible to change its 
name by double clicking on the device. Ensure one and only one peripheral does start with “LIOBOX”. 
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Script 

1.​ Ensure SWS/S&M extension for Reaper is installed. It can be checked in the upper ribbon, 
under Extensions: 

 

2.​ The script folder can be loaded from anywhere on a local drive. Important: avoid virtual or 
sync’d drives, such as Google Drive folders. We recommend copying the script folder in 
<pathto\Reaper\InstallData\Scripts>. 

3.​ Show the action list in ACTIONS/SHOW ACTION LIST… 

 

 

20 
 



     ​  
LIOBOX² - USER MANUAL v11 

4.​ Load script LioboxMaster.lua by clicking NEW ACTION…/LOAD REASCRIPT… 

 

 

The script should now appear in the Script list: 

 

The script can be either be executed: 

●​ At request (launched directly) 
●​ At Project opening 
●​ At Reaper opening 

 

To launch the ReaScript when Project or Reaper opens: 
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5.​ Copy the loaded ReaScript Command ID by right clicking on the Script and COPY SELECTED 
ACTION COMMAND ID

 
6.​ Type “startup” in the filter bar 

 

7.​ Depending if the script is to launch at Project or Reaper startup, select “Set Project (or Set 
Global) startup action and paste the Command ID 

8.​ A confirmation popup shall indicate that the previous step passed 

 

 

Other 

To remove the automatic loading of the script, either “Clear global startup action” or “Clear project 
startup action” 

To display the project or global startup action, launch the command “Show project/global startup 
actions” 

To execute only once: in the Actions list window, select the script and click on the “Run” pushbutton 

 

Note: if the Liobox does not appear, ensure the Liobox is connected prior to launching Reaper. 
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BITWIG 

SETUP 
 

Add the Bitwig extension on MacOS 

●​ Unzip the folder in /Users/<username>/Documents/Bitwig Studio/Extensions 

 

 

Add the Bitwig script on Windows 

●​ Unzip the folder in: <username>/Documents/Bitwig Studio/Extensions 
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Load the extension in Bitwig 

1.​ Connect the LIOBOX² to the computer and start Bitwig. 
2.​ In File → Settings, select Controllers 

 

 

 
3.​ Select Add Controllers, and look for Gooroo Controllers in the Hardware Vendor list. 
4.​ Choose whether the Liobox will take the Master or Spare role and click Add. 

 

 

5.​ Assign the Extension MIDI IN and MIDI OUT to the LIOBOX MIDI ports. Ensure it is enabled. 
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The script works seamlessly either in Mix or Arrangement mode. 

 

SCRIPT ADVANCED FEATURES 
Similarly to Ableton, the Gooroo Controllers Liobox Bitwig extension supports: 

●​ Autonext 
●​ Autostop 
●​ Loop 

Refer to the Ableton section describing these features.  
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PRO TOOLS 

SETUP 
The LIOBOX² native support for Pro Tools is made possible through the use of the GoorooLink 
software.. Refer to the GoorooLink User Manual for more information. 

The following section will cover the Pro Tools software configuration. 

 

Make sure the Gooroo Bridge is selected for Pro Tools. 

1.​ Enable Gooroo Bridge MMC Input: 
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2.​ Associate the MTC Generator Port to the Gooroo Bridge Protools MTC 

 

 

 

3.​ Enable the Machine Control and set the ID to 127 

 

 

 

REDUNDANCY IN PRO TOOLS 
Redundancy in Pro Tools is achieved using the LIOBOX² as a central coordinator and Pro Tools Studio 
features. 

 

Important: Pro Tools Studio (or higher) Jam Sync feature is mandatory to enable this feature. 

 

As Pro Tools can have large sessions, jumping into markers and launching commands requires Pro 
Tools to load for a significant amount of time (from dozens to hundreds of milliseconds) which 
makes Fire-and-Forget commands creating out-of-sync sessions. 

To address this behavior, both the LIOBOX² and the GoorooLink are constantly making sure Pro Tools 
is ready, and syncs commands to launch simultaneously on both computers. 

 

Therefore, the GoorooLink relies heavily on the MTC capabilities and Pro Tools features to be 
enabled: 

●​ Sync Point enabled 
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●​ Setup > Session > Session Timecode Settings: Jam Sync 

 
 

 
 

These features are to be activated on the Spare computer. This configuration is optional for the 
Master computer. 

 

On both Master and Spare computers, ensure Synchronization → MTC is enabled: 
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Having constant LIOBOX MASTER ⇔ PROTOOLS ⇔ LIOBOX SPARE synchronization has impacts on how 
commands are managed: 

●​ Play, Restart, Next, Prev commands: 
○​ Master side: slight delay (a few hundreds milliseconds) at launch to ensure 

playhead positioning and that the Spare is ready too 
○​ Spare side: the playhead catches up approximately 1 second after the Master starts 
○​ Hitting any of these commands while the Spare catches up will result in command 

being discarded 
●​ Pause command 

○​ Deferred while Play, Restart, Next, Prev is launching and Spare synchronizing  
●​ Deactivated commands 

○​ Fast forward and fast rewind commands will be discarded if both Master and Spare 
are connected 
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LOGIC PRO 

SETUP 
The Liobox² native support for Pro Tools is made possible through the use of the GoorooLink Software. 
Refer to the GoorooLink User Manual for more information. 

The following section will cover the Pro Tools software configuration. 

 

Make sure the GoorooLink is selected for Logic Pro. 

1.​ Enable MIDI Input: Gooroo Bridge MMC MIDI 
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2.​ Activate both MTC and MMC Synchronization for: 
○​ Gooroo Link Logic MTC → MTC 
○​ Gooroo Link Logic MMC → MMC 

3.​ Enable both Transmit and Listen MIDI Machine Control (MMC) 
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QLAB 

SETUP 
The LIOBOX² communicates with QLab using the GoorooLink which transforms MIDI to OSC protocol. 

In order to enable this communication, ensure the option is enable in QLab settings: 

File > Workspace Settings > Network > OSC Access 
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CONNECTION STATUS 

 

The LIOBOX² works with DAW thanks to script or through the GoorooLink that loads with the session. 

 

When two computers are used in redundancy, load the Spare script on the second computer, 
depending on your software version. 

 

When the script is loaded in the Ableton, Bitwig or Reaper preferences, the Liobox² transmits and 
reads MIDI information from the main computer.  

The same behavior is reproduced when using the GoorooLink with Pro Tools, Logic Pro or QLab. 

 

Connection status 

Depending on the state of the connection, the Liobox² can display the communication link status as 
a visual confirmation: 

 

Script loaded 
Communication active 

DAW not started 
Script not loaded 

  

 

In case of redundancy, the status of each connection is displayed: 
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ABLETON, REAPER, BITWIG, PRO TOOLS, LOGIC 
MODES 

 

ALL TRACKS MODE 
Switch to ALL TRACKS mode from the Mode menu. 

 

Ableton 

 

Reaper 

 

 

ALL songs mode gives access to all songs present in the DAW session, sorted according to their 
order in the session. 

 

This makes it possible to move around and launch any song in your set. 

In case Error on Duplicate song is enabled, the Liobox² analyzes song names and indicates whether 
two songs (Scene/Benchmark) have the same name, prompting to correct them. 

SETLIST MODE 
SETLIST mode lets you select and rearrange the song order. This way, the Liobox² will only display the 
songs in the show's setlist and in the desired order. All this without ever modifying the DAW session 
or touching the computer.  

Setlists can then be renamed and saved in the LIOBOX²'s internal memory. 
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Switch to Setlist mode from the Mode menu. 

 

Ableton 

 

Reaper 

 

 

Setlist creation 

Add a setlist by selecting + ADD _MODE_ SETLIST in the MENU/SETLIST menu. It is necessary to select 
the mode (Ableton, Reaper, Pro Tools, …) in the MENU/MODE menu prior to creating the setlist. 

The Mode first letter (A/B for Ableton/Bitwig, R for Reaper, …) is prepended to the setlist name to 
indicate the associated mode. 

When songs are added to a setlist, the accumulated time is displayed at the top of the window, next 
to the name of the setlist. 

 

 

Add songs to the setlist 

Once a setlist has been created, songs can be added. The list of songs is directly loaded from the 
Ableton, Bitwig, Reaper, Pro Tools, Logic Pro or QLab active projects.  

 

To add a song, enter the created Setlist and select MODIFY and + ADD song. The list of preloaded 
songs appears. Click to add songs. The same songs can be added multiple times. 

The duration of each song is indicated next to its name (duration entered in the title according to 
the naming protocol). 

 

Setlist Menu Setlist/MODIFY menu ADD songS menu Setlist/MODIFY menu
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When a song is present in the setlist, it appears in green. The same song can be added several 
times to a setlist.  

​
Manage setlist 

Setlists can be renamed (maximum of 12 characters), duplicated and modified at any time. 

If a song in the loaded setlist is not present in the DAW session, it is displayed in red on the Play 
screen. 

 

Up to 9 setlists can be created. 

 

Load a setlist 

To be active in Setlist Mode, the mode must be set to the Setlist mode in the MODE menu. 

 

The setlist name will appear in red in the Play screen if the loaded setlist mode is different from the 
active mode. 

 

TRACK POSITION IN SESSION/SETLIST 
The position of the current song in the session or setlist is constantly displayed at the top of the 
screen. 

TRACK NAMING CONVENTION 
The Liobox² screen can be used to display song BPM, tone and duration information.  

To do this, enter them in the song name according to the following protocol naming convention: 

song_number ; bpm ; tone ; duration 
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Duration shall be in the format of mm:ss. 

If a value is not necessary, leave the field empty and omit the ";". 

If a song is not to be transmitted to the Liobox, add the prefix "()". Example: "()song number 1 ".  

 

Note: the following characters are compatible with the Liobox. Any other character will be filtered 
out. 

●​ Upper case: A to Z  
●​ Numbers: 0 to 9 
●​ Bracket: ( ) 
●​ Square bracket: [ ] 
●​ Hashtag: # 
●​ Ampersand: & 
●​ Plus: + 
●​ Slash: / 
●​ Space 

 

The name starting with the following will not be transmitted to the Liobox²: 

●​ () 
●​ [] 
●​ (LOOP 
●​ _ 
●​ ** 
●​ > 
●​ >> 
●​ + 
●​ LOOP 

 

The following marker name will also be filtered out from the Liobox² received marker list: 

●​ AUTOSTOP 
●​ (STOP) 
●​ (NEXT) 
●​ STOP 
●​ SONG END 
●​ PLAYNEXT 
●​ STOPBOT 
●​ EASY LOOPER 
●​ NEXTCUE 
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ABLETON/BITWIG MODE 
The LIOBOX² manages synchronization with Ableton and Bitwig similarly. Therefore, they share the 
same mode management as well as pad configuration. 

PROTOOLS ONLY 
Note: in Pro Tools, the Memory Location Comments can be used in place of marker extra 
information naming convention. Information can be preceded by “key:”, “duration:” or “bpm:”. 

 

Protools Marker reference 

The marker reference shall only be of type “Absolute”. Otherwise, it will be discarded. 
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LOGIC PRO ONLY 
Deactivate “Play from Cycle” (right click on the Play button) in order to avoid having the playhead 
resetting to its original position instead of playing the selected marker. 

 

QLAB MODE 
The way QLAB works is fundamentally different from other DAW. 

In order to provide a similar level of flexibility as for the other modes, the LIOBOX² does not store 
tracks or setlists but acts more as information displayer, in addition to being able to trigger specific 
commands. 

 

 

Three information can be displayed: 

●​ Latest Go’ed cue 
●​ Selected cue: cue that will be Go’ed if sending Play command 
●​ Remaining / Cue duration 

 
Refer to the GoorooLink documentation for modifying displayed information. 
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MIDI MODES 

TRANSPORT MODE 
MIDI Transport mode allows using the Liobox² with any software or hardware that can receive midi 
via USB. 

Each PAD can send a Note or a Control Change to the USB port, and thus control a DAW or 
instrument function. 

MARKER MODE 
MIDI Marker mode allows creating setlists directly on the LIOBOX² to navigate between songs and 
launch them directly. 

For instance, this mode can be used to create preset change setlists for instruments or autotunes. 
To do so: 

●​ Create markers corresponding to the presets of your instruments. Markers are sorted in the 
order in which they were created 

●​ Assign the marker (internal to LIOBOX²) to the preset using MIDI assignments. 
●​ Once the markers have been created in the LIOBOX, they can be renamed and moved to the 

desired order. 

Multiple setlists can be saved. 
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MENU 

MODE 
Available modes are: 

●​ Ableton, Bitwig, Reaper, Pro Tools, Logic Pro modes 
○​ All songs 
○​ Setlist 

●​ Midi mode 
○​ Transport 
○​ Marker 

●​ QLab mode 

Refer to the previous sections for more information. 

PAD CONFIG 
To enter the pad configuration menu, go to MENU, select the Bank (rotate the knob) and select the 
Pad to be configured. 

   

 

Pad feature 

All pads except MENU and BACK/BANK can be reassigned to custom features. 

Pad can have any of the following events (and/or): 

●​ Short press 
●​ Double press 
●​ Long press 

Events can be activated or deactivated. 

 

 

42 
 



     ​  
LIOBOX² - USER MANUAL v11 

Depending on the selected Mode, pads can be assigned to feature: 

 

ABLETON, BITWIG, REAPER, 
PRO TOOLS, LOGIC PRO 

 MIDI QLAB 

NONE 
PLAY LIOBOX MARKER 

PLAY (TRANSPORT) 
PAUSE 
 STOP 

PREV LIOBOX MARKER 
 PREV MARKER (TRANSPORT) 

FAST-REWIND 
RESTART MARKER 

NEXT LIOBOX MARKER 
NEXT MARKER (TRANSPORT) 

FAST-FORWARD 
LOOP IN/OUT 

LOOP IN 
LOOP OUT 

LOOP ON/OFF 
LOOP CREATE X 
CUSTOM MIDI 

NONE, 
SELECT MARKER 

PLAY 
PAUSE 

PREVIOUS MARKER 
FAST-REWIND 
NEXT MARKER 

FAST-FORWARD 
 CUSTOM MIDI 

 
 

NONE, 
PLAY CUE 

PAUSE 
PREV CUE  
NEXT CUE 

PANIC 
CUSTOM MIDI  

 

Notes: 

●​ Play or Play (Software) correspond to the DAW Play 
●​ Play Marker (Liobox) plays the next song 
●​ Fast-Rewind and Fast-Forward can only be assigned to Long Press pad event 
●​ Next or Prev Marker (Software) correspond to the DAW Next event (next/prev in the project) 
●​ Next or Prev Marker (Liobox) selects the next or previous marker from the setlist 

The activated feature appears in green. 

 

 

Warning: the LIOBOX²'s transport functions transit on port 1. We advise not to use channels 1, 2, 3 and 
4, to avoid conflicts depending on the notes or CC sent. 
 

All events can trigger a Custom Midi event that can either be a Midi note, Control Change or 
Program Change. 

Example of Custom Midi Screen depending on the selected mode 
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Tip: use custom midi to activate Loops or Autotune. 

 

Pad MIDI IN Trigger 

PADs can be controlled by an external instrument, such as a drum module or footswitch connected 
via minijack to LIOBOX²'s MIDI IN. 

The Liobox² can be simulating a Short Press event of any pad from a custom Midi message. 

To enable this feature, it is required to: 

1.​ Enable MIDI IN from the first MENU screen (font in green). 
2.​ Activate pad Midi In Trigger 
3.​ Assign a triggering Midi message 

 

 

Global MIDI IN activated Specific Pad MIDI IN MIDI Message config 

   

 

 

Select the MIDI message that will trigger the PAD function from the menu. 

Activate the function by clicking on ACTIVATE , a MIDI logo appears next to the PAD name on the 
main screen. 

To validate that the MIDI IN Trigger is activated, check that: 

1.​ The MIDI Logo background next to the PLAY icon is white 
2.​ The MIDI Logo for the customized pad is visible and has a white background next to the pad 

name 
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In case the the global MIDI IN is deactivated or no pad has a MIDI IN enabled, the associated logo will 
appear in gray: 

 

Global MIDI enabled but no pad has a MIDI IN 
trigger activated

 

Pad MIDI IN trigger activated but Global MIDI 
disabled 

 

 

Pad LED color 

Pads are RGB backlit. 

Up to 8 colors can be selected from the LED Color menu: Black (off), White, Blue, Red, Green, Yellow, 
Pink, Cyan, Orange. 
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Rename pad 

Each pad can be renamed. The name will appear depending if either ADVANCED or PAD NAMES is 
selected in the Screen Preferences. 

 

LOOP ON-THE-FLY (ABLETON, BITWIG AND REAPER) 
The LIOBOX² is able to trigger Ableton, Bitwig and Reaper Loop modes: 

●​ Loop in: set the loop start marker. The marker is set to the previous bar/beat. 
●​ Loop out: set the loop end marker. The marker is set to the next bar/beat 
●​ Loop in/out: depends on the previous state. If loop in has been set, then loop out will be sent 

at the next press and the other way around. 
●​ Loop on/off: activate/deactivate the loop 
●​ Loop Create X: create a predefined X-beat duration loop. X can be set from 1 to 127. 

 

Note: loop out always activates the loop after being created. This will then move the playhead to the 
loop start marker as soon as the loop end marker is reached and loop indefinitely until a loop off is 
performed. 

BANK MANAGEMENT 
The Liobox² can handle a pad banking system. 

Each bank reflects a unique 4-pad configuration. It is possible to have up to four banks of pad. 

According to this, it is possible to assign up to 48 features per Mode (4 pads, 4 banks, 3 events per 
pad). 

 

The active bank is displayed on the Play screen. 

 

A short press of the BANK SELECTION pad from the MAIN screen iterates through the banks.  

A long press locks the current bank. 
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Bank locked

 

Bank unlocked 

 

 

BANK LOCK NUMBER (MENU → SETTINGS) 
It is also possible to limit the number of banks (to not navigate through empty banks). 

Go to MENU → SETTINGS → BANK LOCK NUMBER, select the maximum pad bank number by rotating 
the knob. Confirm by pressing the knob. 

 

 

REFRESH 
Although the LIOBOX² always automatically updates when the Ableton, Bitwig, Reaper, Pro Tools, 
Logic Pro session is modified, you can also launch a manual refresh via the "REFRESH" menu. 
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SCREEN PREFERENCE (MENU → SETTINGS) 
Default screen option: ADVANCED 

ADVANCED 

 

Other screen options: 

STANDARD (v1) PAD 

  

TIME SIMPLE 

  

 

BPM 

The BPM only accepts integer values without decimals. 
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KEY 

The tone can be entered up to a maximum of 4 characters. 

This insert can be used to enter other information, up to a limit of 4 characters. 

 

DURATION 

Title duration can be entered as "minute : seconds". 

The duration can be entered in seconds, and LIOBOX² will convert the duration to minute/second 
format. 

 

THEME (MENU → SETTINGS) 
The screen can be switched between DARK mode (black background) for dark spaces, and DAY 
mode (white background) for easy viewing of the screen even in bright lighting conditions: 

 

DAY DARK 

  

 

 

 

BRIGHTNESS (MENU → SETTINGS) 
Rotate the knob to change both Display brightness and Pad backlight intensity. 
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ADVANCED SETTINGS (MENU → SETTINGS) 
Show song number: prepends the song number before the song number. 

 

ADVANCED SETTINGS menu 
SHOW song NUMBER DEACTIVATED 

 

PLAY screen 
 

 

ADVANCED SETTINGS menu 
SHOW song NUMBER ACTIVATED 

 

PLAY screen 
 

 

 

 

Error on duplicate song: displays an error message if two setlist songs have the same name. 
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Loop on bar/Loop on Beat: by default, when the LIOBOX² sends a “Loop In” signal to the DAW, the 
script calculates the closest previous bar: loop on bar. 

If the setting is changed to Loop On Beat the script calculates the closest previous beat (1/4 for 
instance). 

 

RESET (MENU → SETTINGS) 
It is possible to retrieve Liobox² default configuration and settings via the Reset menu. 

●​ Pad config reset: sets the default configuration of the pads 
●​ Factory reset: reset the entire Liobox² (theme, mode, screen preference, brightness, pads, 

advanced settings) 

TROUBLESHOOTING 
LIOBOX² does not switch on: 

●​ Check wiring.  
●​ Use the cable provided. 

 

A red cross appears at the top of the screen on start-up that: 

●​ Ableton software has been started. 
●​ The correct script is loaded on port #1 of the Liobox² in the MIDI input and output section. 
●​ If using a HUB or MIDI card, check the wiring to the computer. 

 

Song name not displayed, check that: 

●​ A name has been entered 
●​ The naming procedure has been followed. 
●​ The name is not masked by adding the prefix "()". 

 

No name is displayed even though Liobox² is connected: 

●​ You have exceeded the 120-song limit currently managed by Liobox².  

 

A "caution" symbol appears at the top of the screen, so please check that: 

●​ Both sessions (Main / Spare) have the same song names, and in the same order. 
●​ Make sure both computers are in the same mode (arrangement or session). 

 

The song name in the setlist is displayed in red: 

●​ The song has not been deleted from the Ableton session. 
●​ The song name or info is not correct. 
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LICENSE CONTRACT 
The scripts provided for ABLETON, BITWIG and REAPER are strictly reserved for use with the LIOBOX² 
controller. It is strictly forbidden to modify or use for any other purpose the scripts provided at the 
time of download. GOOROO CONTROLLERS cannot be held responsible for any damage to the 
LIOBOX² or other third-party equipment resulting from modification or misuse of the script or 
software supplied, other than as provided for in this manual. 

 

GOOROO CONTROLLERS is the sole owner of the software embedded in the LIOBOX², as well as the 
scripts supplied at the time of purchase. The sale of the LIOBOX² does not constitute a sale of the 
embedded software or the corresponding script. 

​
GOOROO CONTROLLERS grants a non-exclusive license to use the software under the terms and 
conditions of this contract. The customer may not rent, lend or license the software. 

DECLARATION OF CONFORMITY 
Use of the LIOBOX² for purposes other than those described in this manual may result in 
non-conformity of the equipment and its accessories. 

 

The LIOBOX² complies with the requirements of European Directive 89/336/EEC. 

Modifying the device or using accessories not supplied by GOOROO CONTROLLERS may result in the 
equipment being banned from use in Europe. 

 

LIOBOX² meets FCC requirements 

Modifying the device or using accessories not supplied by GOOROO CONTROLLERS may result in 
prohibition of use in the USA.  
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TRADEMARK ATTRIBUTION 
All product names, logos, symbols, and brands featured or referred to within this manual are the 
property of their respective trademark holders. These trademark holders are not affiliated with 
Gooroo Controllers, our products, or our website. They do not sponsor or endorse our materials. 

The use of any third-party names or logos is strictly for identification and descriptive purposes to 
provide context and instructions for the user. Any such use falls under "nominative fair use" and does 
not imply any association with the trademark holder. 

LIMITATION OF LIABILITY 
The information contained in this manual is provided "as is" and for informational purposes only. 
While every effort has been made to ensure the accuracy of the content, Gooroo Controllers 
assumes no responsibility for errors or omissions, or for damages resulting from the use of the 
information contained herein. 

Furthermore, Gooroo Controllers shall not be held liable for: 

●​ Any issues arising from the use of third-party hardware or software mentioned in this guide. 
●​ Direct, indirect, incidental, or consequential damages resulting from the performance or use 

of the instructions provided. 
●​ Changes in third-party interfaces or functionality that may render these instructions 

obsolete. 
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